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Configuring Features and Services for 
Cisco IP Communicator

After you add Cisco IP Communicator to Cisco Unified Communications Manager (formerly known as 
Cisco Unified CallManager), you can add users, configure telephony features, modify phone templates, 
and set up services for Cisco IP Communicator. You can also configure product-specific settings for 
Cisco IP Communicator.

• About Adding Users to Cisco Unified Communications Manager, page 5-1

• Telephony Features Available for Cisco IP Communicator, page 5-2

• About Modifying Phone Button Templates, page 5-6

• About Configuring Softkey Templates, page 5-7

• Setting Up Services, page 5-7

• About Configuring Corporate and Personal Directories, page 5-8

Tip In general, it is preferable to configure the settings in Cisco Unified Communications Manager 
Administration before deploying Cisco IP Communicator to ensure that features are set up properly for 
the user at first launch and remain consistent thereafter.

About Adding Users to Cisco Unified Communications Manager
When you add users through Cisco Unified Communications Manager Administration, you can display 
and maintain information about them. After they are added, users can perform these actions:

• Set up speed dial and call forwarding numbers 

• Subscribe to services that are accessible from Cisco IP Communicator

• Access the corporate directory and other customized directories from Cisco IP Communicator

• Create a personal directory (Personal Address Book service)
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Telephony Features Available for Cisco IP Communicator
You can add users to Cisco Unified Communications Manager by using either of these methods:

• To add users individually:

– In Release 5.x and later: choose User Management > End User.

– In Release 4.x: choose User > Add a New User.

For details about adding users, see the Cisco Unified Communications Manager Administration 
Guide. For details about user information, see the Cisco Unified Communications Manager System 
Guide.

http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_maintenance_guides_list.html

• To add users in batches, use the Bulk Administration Tool (BAT). This method also enables you to 
set an identical default password for all users.

For details, see the Bulk Administration Tool User Guide at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/products_user_guide_list.html

Related Topics

• Telephony Features Available for Cisco IP Communicator, page 5-2

• About Modifying Phone Button Templates, page 5-6

• About Configuring Softkey Templates, page 5-7

• Setting Up Services, page 5-7

• About Configuring Corporate and Personal Directories, page 5-8

Telephony Features Available for Cisco IP Communicator
After you add Cisco IP Communicator devices to Cisco Unified Communications Manager, you can add 
functionality to those devices. Table 5-1 lists the supported telephony features, many of which you can 
configure through Cisco Unified Communications Manager Administration. 

Note • If Cisco IP Communicator does not appear in the Device > Phone > Phone Type drop-down list, 
install the latest support patch for your server version from this URL:
http://www.cisco.com/kobayashi/sw-center/sw-voice.shtml

• Cisco Unified Communications Manager documentation is available from the application Help 
menu and from this URL:
http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html
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Telephony Features Available for Cisco IP Communicator
Table 5-1 Configuring Telephony Features Through Cisco Unified Communications Manager Administration

Feature Description For details, see...

Abbreviated 
dialing

A user can configure up to 99 speed-dial entries. 
Speed-dial entries that are not assigned to the 
speed-dial buttons on Cisco IP Communicator are used 
for abbreviated dialing. When a user starts dialing 
digits, the AbbrDial softkey appears, and the user can 
access any speed-dial entry by entering the appropriate 
index.

Cisco Unified Communications Manager 
Administration Guide (abbreviated dialing and 
speed dialing)

Auto answer Causes the speakerphone or headset to automatically 
go off-hook when an incoming call is received.

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
Features and Services Guide

Barge Allows a user to join an in-progress call on a shared 
line. Phones support Barge in two conference modes:

• Built-in conference bridge at the target device (the 
phone that is being barged). This mode uses the 
Barge softkey.

• Shared conference bridge. This mode uses the 
cBarge softkey.

Cisco Unified Communications Manager 
Features and Services Guide

Block 
external-to-externa
l transfer

Prevents users from transferring an external call to 
another external number.

Cisco Unified Communications Manager 
Features and Services Guide

Call display 
restrictions

Determines the information that displays for calling or 
connected lines, depending on the parties who are 
involved in the call.

Cisco Unified Communications Manager 
Features and Services Guide

Call park Places the call on hold so that anyone connected to the 
Cisco Unified Communications Manager system can 
retrieve the call.

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
Features and Services Guide

Call pickup Picks up incoming calls within a group. • Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
System Guide

Call waiting Receives a second incoming call on the same line 
without disconnecting the first call.

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
System Guide

Caller ID Displays the telephone number and name of the caller. Cisco Unified Communications Manager 
Administration Guide

Cisco Call Back Allows a user to receive call back notification on a 
Cisco Unified IP Phone when the line for a called 
party becomes available.

Cisco Unified Communications Manager 
Features and Services Guide
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Telephony Features Available for Cisco IP Communicator
Cisco Unified 
Communications
Manager Assistant 

Enables managers and their assistants to work together 
more effectively by providing a call-routing service, 
enhancements to phone capabilities for the manager, 
and desktop interfaces that are primarily used by the 
assistant.

• Cisco Unified Communications Manager 
Features and Services Guide

• Cisco Unified Communications Manager 
Administration Guide (system 
requirements, installation and 
configuration instructions, and use 
information)

CMC1 Enables a user to specify that a call relates to a specific 
client matter.

Cisco Unified Communications Manager 
Features and Services Guide

Conference Initiates an ad-hoc conference and then conferences in 
other participants one at a time.

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
System Guide

Configurable call 
forward display

Allows you to specify information that appears on a 
phone when a call is forwarded. This information can 
include the caller name, caller number, redirected 
number, and original dialed number.

Cisco Unified Communications Manager 
Administration Guide

Direct transfer Joins two established calls (calls that are on hold or in 
a connected state) into one call and drops the feature 
initiator from the call. Does not initiate a consultation 
call and does not put the active call on hold.

Cisco Unified Communications Manager 
System Guide

Do Not Disturb 
(DND)

Allows a user to block incoming calls with a busy tone. Cisco Unified Communications Manager 
Administration Guide, SIP Profile 
Configuration chapter (Release 5.x)

FAC2 Controls the types of calls that certain users can place. Cisco Unified Communications Manager 
Features and Services Guide

Forward Forwards all calls to the designated directory number. Cisco Unified Communications Manager 
Administration Guide

Group call pickup Allows users to pick up incoming calls within their 
own group or in other groups.

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
System Guide

Hold Places an active call on hold. Requires no configuration, unless you want to 
use music on hold; see “Music-on-Hold” in 
this table

Immediate Divert Immediately diverts a call to a voice messaging 
system. When a call is diverted, the line becomes 
available to make or receive new calls.

Cisco Unified Communications Manager 
Features and Services Guide

Join Allows a user to initiate an ad-hoc conference by using 
the Join softkey.

Join does not create a consultation call and does not 
put the active call on hold. Join can include more than 
two calls, which results in a call with more than three 
parties.

•  About Configuring Softkey Templates, 
page 5-7

• Cisco Unified Communications Manager 
Administration Guide

Table 5-1 Configuring Telephony Features Through Cisco Unified Communications Manager Administration 

Feature Description For details, see...
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Telephony Features Available for Cisco IP Communicator
MCID3 Allows you to report a call of a malicious nature by 
requesting that Cisco Unified 
Communications Manager identify and register the 
source of an incoming call in the network.

Cisco Unified Communications Manager 
Features and Services Guide

Meet-Me 
conference

Enables other callers to join a conference. Cisco Unified Communications Manager 
Administration Guide

Message waiting Indicates that one or more voice messages are waiting 
for a user.

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
System Guide

MLPP4 Allows properly validated users to place priority calls. 
If necessary, users can preempt lower-priority phone 
calls. Also allows the use of the CFAP5 feature for 
forwarding a precedence call.

Cisco Unified Communications Manager 
Features and Services Guide 

Music-on- hold Plays music while callers are on hold. Cisco Unified Communications Manager 
Features and Services Guide

Privacy Enables or disables whether users with phones that 
share the same line can view call status and can barge 
a call.

Cisco Unified Communications Manager 
Features and Services Guide (system 
requirements, configuration instructions, and 
use information)

QRT6 Allows users to use the QRT softkey on a phone to 
submit information about problem phone calls. QRT 
can be configured for either of two user modes, 
depending upon the amount of user interaction desired 
with QRT.

Cisco Unified Communications Manager 
Features and Services Guide

Redial Redials the last number dialed on the 
Cisco Unified IP Phone.

Requires no configuration

Ring setting Identifies ring type used for a line when a phone has 
another active call.

Cisco Unified Communications Manager 
Administration Guide

Users can adjust their ring settings from the 
Cisco Unified Communications Manager 
User Options web pages.

Services Allows you to use the Cisco Unified IP Phone Services 
Configuration menu to define and maintain the list of 
phone services to which users can subscribe.

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
System Guide

Services URL 
button

Provides one-touch access to information services. Cisco Unified Communications Manager 
Administration Guide 

Speed-dial Dials a specified number that has been previously 
stored.

Cisco Unified Communications Manager 
Administration Guide

Table 5-1 Configuring Telephony Features Through Cisco Unified Communications Manager Administration 

Feature Description For details, see...
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About Modifying Phone Button Templates
Related Topics

• About Modifying Phone Button Templates, page 5-6

• About Configuring Softkey Templates, page 5-7

• Setting Up Services, page 5-7

• About Configuring Corporate and Personal Directories, page 5-8

About Modifying Phone Button Templates
Phone button templates let you assign features to line and speed dial buttons. You should modify 
templates before registering devices on the network. In this way, you can access customized template 
options from Cisco Unified Communications Manager during registration.

You modify a template from Device > Device Settings > Phone Button Template. You assign a template 
to a device on the Phone Configuration window (Phone Button Template field). For details, see the 
Cisco Unified Communications Manager Administration Guide and Cisco Unified 
Communications Manager System Guide at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_maintenance_guides_list.html

Time-of-Day 
Routing

Restricts access to specified telephony features by time 
period.

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
System Guide

Transfer Transfers an active call to another directory number. Requires no configuration

Video Support Enables video support.

For details about supported Cisco Unified 
Video Advantage and Cisco Unified 
Communications Manager releases, see the server 
requirements section of the release notes at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps
5475/prod_release_notes_list.html

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
System Guide

• Cisco Unified Video Advantage 
Administration Guide

Voice messaging 
system

Enables callers to leave voice messages if calls are 
unanswered.

• Cisco Unified Communications Manager 
Administration Guide

• Cisco Unified Communications Manager 
System Guide

1. CMC = Client matter codes

2. FAC = forced authorization codes

3. MCID = malicious caller identification

4. MLPP = Multilevel Precedence and Preemption

5. CFAP = call-forward alternate party

6. QRT = Quality Reporting Tool

Table 5-1 Configuring Telephony Features Through Cisco Unified Communications Manager Administration 

Feature Description For details, see...
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About Configuring Softkey Templates
The default Cisco IP Communicator template uses buttons 1 and 2 for lines and assigns buttons 3 
through 8 for speed dial numbers. You access other telephony features (such as call park, call forward, 
redial, hold, resume, voice messaging system, conferencing, and so on) by using 
Cisco IP Communicator softkeys.

Related Topics

• Telephony Features Available for Cisco IP Communicator, page 5-2

• About Configuring Softkey Templates, page 5-7

• Setting Up Services, page 5-7

About Configuring Softkey Templates
By using Cisco Unified Communications Manager, you can manage softkeys associated with 
applications that are supported by Cisco IP Communicator. Cisco Unified Communications Manager 
supports two types of softkey templates: standard and nonstandard. An application that supports softkeys 
can have one or more standard softkey templates associated with it. You cannot modify standard softkey 
templates; you can modify only nonstandard templates.

You configure softkey templates from Device > Device Settings > Softkey Template. You assign a 
softkey template to a device on the Phone Configuration window (Softkey Template field). For details, 
see the Cisco Unified Communications Manager Administration Guide and the Cisco Unified 
Communications Manager System Guide at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_maintenance_guides_list.html

Related Topics

• Telephony Features Available for Cisco IP Communicator, page 5-2

• About Modifying Phone Button Templates, page 5-6

• Setting Up Services, page 5-7

Setting Up Services
Users can click the Services button on Cisco IP Communicator to access XML applications that enable 
the display of interactive content with text and graphics on the Cisco IP Communicator phone screen. 
Examples of services include local movie times, stock quotes, and weather reports. Before a user can 
access these services, you must perform this procedure.

Procedure

Step 1 Gather the URLs for the sites you want to set up, and verify that users can access those sites from your 
corporate IP telephony network. 

Step 2 Configure available services:

• In Release 5.x and later: Device > Device Settings > Phone Services 

• In Release 4.x: Features > Cisco Unified IP Phone Services 

For details, see Cisco Unified Communications Manager Administration Guide and Cisco Unified 
Communications Manager System Guide at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_maintenance_guides_list.html
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Step 3 Verify that your users have access to the User Options web pages from which they can select and 
subscribe to configured services. For details that you must provide to users, see Appendix A, “Providing 
Information to Users About Cisco IP Communicator.”

Step 4 Tell users to access the User Options web page through Cisco IP Communicator (right-click > Cisco 
User Options) and to subscribe to services. 

Related Topics

• Telephony Features Available for Cisco IP Communicator, page 5-2

• About Modifying Phone Button Templates, page 5-6

• About Configuring Softkey Templates, page 5-7

About Configuring Corporate and Personal Directories
Through Cisco IP Communicator, users can search corporate and personal directories if you integrate 
Cisco Unified Communications Manager with a directory server and configure the Quick Search feature.

• Directory Search Features, page 5-8

• Cisco Unified Communications Manager Integration with a Directory Server, page 5-9

• How to Configure Quick Search, page 5-9

Directory Search Features 
Table 5-2 lists the directory search features that are supported by Cisco IP Communicator.

Table 5-2 Directory Search Features Supported by Cisco IP Communicator

Search Feature To Invoke... Configuration Tasks

Corporate directory searches 
through the Directories button

Click the Cisco IP Communicator 
Directories button, or enter a shortcut 
(Ctrl + D), and then choose the directory 
from the phone screen menu.

If necessary, integrate Cisco Unified 
Communications Manager with a directory 
server; no additional configuration is required.

See the “Cisco Unified 
Communications Manager Integration with a 
Directory Server” section on page 5-9.

Corporate and personal 
directory searches through the 
Quick Search feature

Cisco IP Communicator (right-click > 
Quick Search), or enter a shortcut 
(Alt + K).

This feature is specific to 
Cisco IP Communicator.

Use the Cisco IP Communicator Directory 
Wizard to configure the Quick Search feature 
(and the Dialing Rules feature).

Users can create personal directories by 
subscribing to the Personal Address Book 
service from the User Options web page. 

See the “How to Configure Quick Search” 
section on page 5-9.
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About Configuring Corporate and Personal Directories
Related Topics

• Specifying User Authentication Information for Quick Search with Windows-Based Cisco Unified 
Communications Managers, page 5-13

• Applying Dialing Rules to Quick Search Dialing, page 5-14

Cisco Unified Communications Manager Integration with a Directory Server
To allow searches against corporate and personal directories through the Cisco IP Communicator 
Directories button, integrate Cisco Unified Communications Manager with a directory server (if 
necessary). You might have already completed this task to support other phone devices in your network.

For details, see the Installing the Cisco Unified Communications Manager Customer Directory 
Configuration Plugin at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_installation_guides_list.html

This document guides you through the process of integrating Cisco Unified Communications Manager 
with Microsoft Active Directory and Netscape Directory Server.

Related Topics

• Directory Search Features, page 5-8

• How to Configure Quick Search, page 5-9

How to Configure Quick Search
Quick Search allows users to search one or more directories (corporate and personal address books) with 
a single search command. 

You can set up Quick Search to function in these ways:

• To apply to all devices in a Cisco Unified Communications Manager cluster or to access directories 
that exist on Cisco Unified Communications Manager 

Use the Cisco IP Communicator Directory Wizard to configure Quick Search. The Directory Wizard 
creates an XML configuration file (LdapDirectories.xml) that tells Cisco IP Communicator which 
Lightweight Directory Access Protocol (LDAP) directories to search.

Personal directory searches 
through the Services button

Click the Cisco IP Communicator Services 
button, or enter a shortcut (Ctrl + R)1, and 
then choose the Personal Address Book 
service from the phone screen menu.

Users create personal directories by 
subscribing to the Personal Address Book 
service from the User Options web page. 

See the “Configuring Quick Search to Access a 
Personal Address Book with Windows-Based 
Cisco Unified Communications Managers” 
section on page 5-15.

1. In all releases prior to Release 2.0, this keyboard shortcut is Ctrl + V

Table 5-2 Directory Search Features Supported by Cisco IP Communicator (continued)

Search Feature To Invoke... Configuration Tasks
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• To apply to a specific Cisco IP Communicator device or to access directories that are external to 
Cisco Unified Communications Manager 

Manually create a custom Quick Search configuration file that tells Cisco IP Communicator which 
LDAP directories to search.

Cisco IP Communicator downloads the LdapDirectories.xml file at startup and saves the list of specified 
LDAP directories. When a user invokes the Quick Search feature, Cisco IP Communicator searches the 
specified LDAP directories, stopping at the first directory where one or more matches are found. 
Therefore, if you specify two directories, and the search string is matched in the first directory, the 
second directory is not searched regardless of whether or not it contains matching entries.

Tip On the Cisco Unified Communications Manager Administration User Configuration window, make sure 
that the Telephone Number field shows the phone number for the user. The Quick Search feature displays 
this phone number in search results.

Related Topics

• Configuring Quick Search by Using the Directory Wizard, page 5-10

• Configuring Quick Search Manually with Windows-Based Cisco Unified 
Communications Managers, page 5-12

• Specifying User Authentication Information for Quick Search with Windows-Based Cisco Unified 
Communications Managers, page 5-13

• Applying Dialing Rules to Quick Search Dialing, page 5-14

• Configuring Quick Search to Access a Personal Address Book with Windows-Based Cisco Unified 
Communications Managers, page 5-15

Configuring Quick Search by Using the Directory Wizard

Use this procedure only if you are setting up Quick Search to access a personal or a corporate directory 
for all Cisco IP Communicator devices that exists on the Cisco Unified Communications Manager 
server. Otherwise, follow the procedure in the “Configuring Quick Search Manually with 
Windows-Based Cisco Unified Communications Managers” section on page 5-12.

Before You Begin

• Obtain the Cisco IP Communicator Administration Tool from this URL:

http://www.cisco.com/cgi-bin/tablebuild.pl/ip-comm

From the Zip file:

– For Windows-based Cisco Unified Communications Managers, obtain the 
Cisco IP Communicator Administration tool, which includes the Directory Wizard.

– For Linux-based Cisco Unified Communications Managers, obtain the Directory Wizard tool 
(directorywizard. cop.sgn).

• For Linux-based Cisco Unified Communications Managers, before running the Cisco Options 
Package (COP) installer, make sure to synchronize the LDAP directories so that the 
LDAPDirectories.xml and the LdapDialingRules.xml files are created correctly.
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• Run the Cisco IP Communicator Administration Tool on the Cisco Unified 
Communications Manager publisher to install the Directory Wizard. For Windows-based 
Cisco Unified Communications Managers, the tool installs DirectoryWizard.exe and 
LdapDirectories.README.txt in this folder: TFTPPath\Communicator. 

Note Obtain the Cisco IP Communicator Administration Tool from the product software download web site: 
http://tools.cisco.com/support/downloads/pub/Redirect.x?mdfid=278468661. It is located inside the 
zipped folder with your build.

Restrictions

• Quick Search is supported when Cisco IP Communicator is integrated with Windows-based 
Cisco Unified Communications Manager Release 4.x. 

• Quick Search of the Personal Address Book is supported when Cisco IP Communicator is integrated 
with Linux-based Cisco Unified Communications Managers, Release 5.x and later.

Procedure for Linux-based Cisco Unified Communications Managers

Step 1 Install the COP file on the Linux-based Cisco Unified Communications Manager.

Step 2 In Cisco Unified Communications Manager Administration, navigate to Cisco Unified OS 
Administration and click Go.

Step 3 Enter your Administrator username and password.

Step 4 Choose Software Upgrades > Install/Upgrade to install the COP file. 

Step 5 Follow the instructions from the online help.

Procedure for Windows-based Cisco Unified Communications Managers

Step 1 Launch the Cisco IP Communicator Directory Wizard (directorywizard.exe) from the program group or 
from the Cisco IP Communicator Administration Tool. 

Step 2 Enter information as prompted. (See the Tips section that follows for help.)

Step 3 Restart the TFTP service by navigating to Cisco Unified Communications Manager Serviceability 
window and choosing Tools > Control Center).

Note You must restart the TFTP service after completing the Directory Wizard—both for new configurations 
and updates.

Based on the information that you entered, the Directory Wizard creates directory and/or Dialing Rules 
configuration files and stores these files in the appropriate location on the server so that Cisco Unified 
Communications Manager can access them. 

Tips for Configuring Directory Wizard on Windows-based Cisco Unified Communications Manager

• Directory Wizard prompts you to make decisions about user authentication. To help you make these 
decisions, see the “Specifying User Authentication Information for Quick Search with 
Windows-Based Cisco Unified Communications Managers” section on page 5-13.
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• You can use Directory Wizard to configure the Dialing Rules feature at the same time that you 
configure Quick Search, or you can do it at another time as a separate task. See the “Applying 
Dialing Rules to Quick Search Dialing” section on page 5-14.

• The auto-detection feature in the Directory Wizard works only if you have installed and run 
Directory Wizard on the Cisco Unified Communications Manager publisher.

• Typically, the Cisco Unified Communications Manager publisher is also the TFTP server where 
phone loads will be installed. If this is not the case, copy the LdapDirectories.xml and the 
LdapDialingRules.xml files to the TFTP server (after running the Directory Wizard on the 
Cisco Unified Communications Manager publisher.)

• In the Cisco Unified Communications Manager Administration Phone Configuration window, if you 
leave the LDAP Server Information File field blank, Cisco IP Communicator users automatically 
use the configuration generated by the Directory Wizard (assuming configuration files are placed in 
the correct location).

• Directory Wizard does not use any existing information that you entered but always creates new 
files. Therefore, make sure to back up your previous configuration if you want to access it again.

• Users must restart Cisco IP Communicator before accessing the Quick Search feature.

Related Topics

• Configuring Quick Search Manually with Windows-Based Cisco Unified 
Communications Managers, page 5-12

• Specifying User Authentication Information for Quick Search with Windows-Based Cisco Unified 
Communications Managers, page 5-13

• Applying Dialing Rules to Quick Search Dialing, page 5-14

Configuring Quick Search Manually with Windows-Based Cisco Unified 
Communications Managers

You must manually create the Quick Search configuration file if either of these situations apply: 

• You want to apply special Quick Search configuration parameters to specific 
Cisco IP Communicator devices (not to all devices).

• You want Quick Search to access a personal or corporate directory that is external to the 
Cisco Unified Communications Manager server.

Before You Begin

• Obtain the Cisco IP Communicator Administration Tool from this URL:

http://www.cisco.com/cgi-bin/tablebuild.pl/ip-comm

• Run the Cisco IP Communicator Administration Tool on the Cisco Unified 
Communications Manager publisher to install the Directory Wizard. The tool installs 
DirectoryWizard.exe and LdapDirectories.README.txt in this folder: TFTPPath\Communicator. 

Restrictions

• Configuring Quick Search manually applies only to Windows-based Cisco Unified 
Communications Manager Release 4.x. 
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Procedure

Step 1 Open the LdapDirectories.README.TXT file from the Cisco IP Communicator program group.

Step 2 Follow the instructions in this example file to create a custom LdapDirectories.xml file.

Step 3 Store the file in a location relative to TFTPpath.

Step 4 Specify the filename and path in the Phone Configuration window (LDAP Server Information File field) 
of Cisco Unified Communications Manager Administration.

Step 5 Restart the TFTP service by navigating to the Cisco Unified Communications Manager Serviceability 
window, and by choosing Tools > Control Center.

Related Topics

• Configuring Quick Search by Using the Directory Wizard, page 5-10

• Specifying User Authentication Information for Quick Search with Windows-Based Cisco Unified 
Communications Managers, page 5-13

• Applying Dialing Rules to Quick Search Dialing, page 5-14

Specifying User Authentication Information for Quick Search with Windows-Based Cisco Unified 
Communications Managers

Cisco Unified Communications Manager uses an LDAP directory to store authentication and 
authorization information. Authentication establishes the right of the user to access the system and 
identifies the telephony resources that a user is permitted to use, such as a specific telephone extension.

To configure Quick Search, you must decide how user authentication is going to work. (This is true 
whether you configure Quick Search through the Directory Wizard or through manual methods.) 

These are your options:

• Specify a global user ID and password (recommended).

This approach allows Quick Search to search corporate and personal directories even when the user 
does not specify any credentials in Cisco IP Communicator.

• Do not specify a user ID or password.

With this approach, you must provide users with their user ID and password and tell them to enter 
this information in Cisco IP Communicator (right-click > Preferences > Directories tab). If user 
authentication credentials are not specified either in the Quick Search configuration file or the 
Directories tab, the feature will not function properly.

Implementation Tips

• Do not use global credentials if any Cisco Unified Communications Manager user ID does not 
match the directory user ID. You specify the user ID in Cisco Unified Communications Manager 
Administration on the User Configuration window. This could be the case if you are using Microsoft 
Active Directory or Netscape with Cisco Unified Communications Manager.

• Users should enter the credentials for the directory account of the directory that will be searched. If 
more than one directory will be searched, the credential information must be the same for all of the 
them.
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Related Topics

• Configuring Quick Search by Using the Directory Wizard, page 5-10

• Configuring Quick Search Manually with Windows-Based Cisco Unified 
Communications Managers, page 5-12

• Applying Dialing Rules to Quick Search Dialing, page 5-14

Applying Dialing Rules to Quick Search Dialing

The Cisco IP Communicator Dialing Rules feature applies pre-established dialing rules stored in 
Cisco Unified Communications Manager to Quick Search phone numbers. Before you can use the 
Cisco IP Communicator Dialing Rules feature, make sure that you set up dialing rules in your 
Cisco Unified Communications Manager cluster. You have these options:

• Set up route patterns to apply to all methods of making a call.

A route pattern comprises a string of digits (an address) and a set of associated digit manipulations 
that route calls to a route list or a to gateway. Route patterns provide flexibility in network design. 
They work with route filters and route lists to direct calls to specific devices and to include, exclude, 
or modify specific digit patterns. You configure route patterns as follows:

– Release 5.x and later: Call Routing > Route/Hunt > Route Pattern

– Release 4.x: Route Plan > Route/Hunt > Route Pattern 

• Set up application dialing rules to apply to calls made by using an application like 
Cisco IP Communicator. 

Application dialing rules automatically strip numbers from or add numbers to telephone numbers 
that the user dials. For example, the dial rules automatically add the digit 9 in front of a 7-digit 
telephone number to provide access to an outside line. You configure application dialing rules as 
follows:

– Release 5.x and later: Call Routing > Dial Rules > Application Dial Rules 

– Release 4.x: Route Plan > Application Dial Rules 

If you are using application dialing rules instead of a route pattern, you must set up a configuration file 
that tells Cisco IP Communicator where to find the dialing rules stored in Cisco Unified 
Communications Manager. To set up the Dialing Rules file, launch the Cisco IP Communicator 
Directory Wizard, and follow the relevant steps. The wizard can help you configure the Quick Search 
feature and Dialing Rules. 

Tip Users must restart Cisco IP Communicator before dialing rules apply to Quick Search dialing.

For details about route plan options, see the Cisco Unified Communications Manager System Guide and 
the Cisco Unified Communications Manager Administration Guide at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_maintenance_guides_list.html

Related Topics

• Configuring Quick Search by Using the Directory Wizard, page 5-10

• Configuring Quick Search Manually with Windows-Based Cisco Unified 
Communications Managers, page 5-12

• Specifying User Authentication Information for Quick Search with Windows-Based Cisco Unified 
Communications Managers, page 5-13
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Configuring Quick Search to Access a Personal Address Book with Windows-Based Cisco Unified 
Communications Managers

Personal Directory provides a personal address book that is stored in the Cisco Unified 
Communications Manager LDAP directory. Personal directory also provides these features:

• Cisco Unified IP Phone Address Book Synchronizer—Allows users to synchronize Microsoft 
Outlook and Outlook Express address book entries with the directory in Cisco Unified 
Communications Manager.

• Two Cisco Unified IP Phone services—The Personal Address Book service and the Personal Fast 
Dial service. From Cisco IP Communicator, a user can search and dial from the Personal Address 
Book service.

If properly configured, Quick Search searches against the Personal Address Book for the user first and 
against a corporate directory second. Quick Search stops at the first directory where it finds a match.

Procedure 

Step 1 Configure Quick Search to integrate with personal directories. See the “Configuring Quick Search by 
Using the Directory Wizard” section on page 5-10.

Step 2 Create the service on the IP Phone Services Configuration window. 

For details, see the Cisco Unified Communications Manager Administration Guide at this URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/prod_maintenance_guides_list.html

Step 3 Tell users to subscribe to the Personal Address Book service in Cisco IP Communicator (right-click > 
Cisco User Options).

Step 4 Provide users with the directory username and password to enter in Cisco IP Communicator 
(right-click > Preferences > Directories tab). 

Users should enter the credentials for the directory account of the directory that will be searched. If more 
than one directory will be searched, the credential information must be the same for all of the them.

Step 5 For users who want to synchronize with Microsoft Outlook, provide the Cisco Unified IP Phone Address 
Book Synchronizer utility, and tell them to install it.

You obtain the software as follows:

• For Release 5.x and later: Application > Plugins > Cisco Unified IP Phone Address Book 
Synchronizer 

• For Release 4.x: Application > Install Plugins > Cisco Unified Communications Manager 
Address Book Synchronizer 

Step 6 Use the URL to download the software.

Related Topics

• Specifying User Authentication Information for Quick Search with Windows-Based Cisco Unified 
Communications Managers, page 5-13

• Appendix A, “Providing Information to Users About Cisco IP Communicator”
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